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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Accés aux options de paramétrage
Outils > Options

Clic droit 3 +clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 #E+T Ouvre la fenétre Styles & Formatage
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Eléments graphiques dans Calc

Calc est souvent utilisé pour présenter des données et faire des budgets et des prévisions. Les
éléments graphiques peuvent transformer un document quelconque en un document dont on se
souvient. Calc peut importer différents formats de fichiers vectoriels (dessin de lignes) et matriciels
(bitmap). Les formats graphiques les plus couramment utilisés sont GIF, JPG, PNG et BMP. Voir
I'Aide pour la liste compléte des formats que LibreOffice peut importer.

Les éléments graphiques dans Calc peuvent étre regroupés en trois types :
* les fichiers d'image, comme les photos, les dessins et les images scannées ;
* les diagrammes créés avec les outils de dessin de LibreOffice ;
* les diagrammes et graphiques créés par les fonctions Diagrammes de LibreOffice.

Ce chapitre couvre les images et les diagrammes. Les graphiques sont décrits Chapitre 3 (Créer
des diagrammes et des graphiques).

Bien que l'usage des éléments graphiques dans Calc soit trés similaire a l'usage des éléments
graphiques dans d'autres composants de LibreOffice, ce chapitre explique certaines différences
dans leur utilisation. Il couvre également certaines fonctions graphiques plus avancées et la fagon
dont elles peuvent améliorer en fin de compte votre classeur.

L'expression éléments graphiques se référe a la fois aux images et aux objets
Note dessinés. Souvent le mot images est utilisé pour se référer aux images et autres
éléments graphiques qui ne sont pas des objets dessinés.

Ajouter des images

Les images, comme des logos de sociétés ou des photographies de personnes ou de produits,
sont probablement les types les plus courants d'éléments graphiques ajoutés a un document Calc.
lls peuvent étre téléchargés depuis Internet, scannés ou créés avec des logiciels graphiques, ou
bien encore des photos prises avec un appareil numérique.

Les images peuvent étre insérées de trois maniéres :
¢ en utilisant la boite de dialogue Insérer une image ;

* depuis la Gallery ;
* depuis le presse-papiers en copiant et collant.

Insérer un fichier image
La maniére la plus ordinaire d'insérer une image est peut-étre d'utiliser un fichier existant.

Pour insérer une image depuis un fichier, utilisez la boite de dialogue Insérer une image.

Boite de dialogue Insérer une image

1) Cliquez a I'endroit dans le document Calc ou vous voulez que I'image apparaisse. Ne vous
souciez pas trop du positionnement exact de l'image a cette étape ; I'emplacement pourra
facilement étre changé comme décrit dans “Positionner des éléments graphiques” page 22.

2) Choisissez Insertion > Image > A partir d'un fichier dans la barre de menus, ou cliquez
sur l'icéne A partir d'un fichier Eh] dans la barre d'outils Dessin.

3) Dans la boite de dialogue Insérer une image (Figure 1), naviguez jusqu'au fichier a insérer,
sélectionnez-le et cliquez sur Ouvrir.
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L'image est insérée dans Calc de sorte qu'elle flotte au-dessus des cellules et qu'elle
soit ancrée a la page, c'est-a-dire la feuille dans laquelle le focus était placé. Voir
Note N . P . ) . .
Positionner des éléments graphiques” page 22 pour plus d'informations sur le
positionnement et I'ancrage des éléments graphiques.

Insérer une image @
EA\Users\CCH\Documents\Libre Office\Calc04 (=] [F) )
Emplacements | [Titre |Type |Taille |Date d
(1 Mes documen| )" Chapitred_Va.jpg Images (jpg) 2632 Ko 16/C =
(3 Calcos d Figurel.png Images (png) 9989 Octets 27/([E 2 E
|=3 FigurelQ-36.png Images (png) 219 Ke 02/C =
=3 Figureld.png Images (png) 26,9 Ke 010 8
|=3 Figurell-36.png Images (png) 149 Ke 02/C 3
|=3 Figurell.png Images (png) 10,0 Ke 01/C i -;-"-_‘
—_— |=3 Figurel2-36.png Images (png) 21,3 Ke 02/C @
| + || - | |=3 Figurel2.png Images (png) 464 Ke 01/ ~ ,é
e : - Par ditmt — Styls d celuls [
Hom defichier: Figurel.png : Titre — Style de cellule
L 3 |Rdsudrat - Stle do cellula
Type defichier: |<Tou5|e5fnrmat5> ("'.bmp;".dxf;*.emf;*.eps;*.gif;*.jpg;*.jplzl Annuler ¢ Bfsdlarl - Sude e celuls

Aide

Lier | Apercu

Figure 1 : Insérer une image depuis un fichier

En bas de la boite de dialogue se trouvent deux options, Apercu et Lier. Sélectionnez Apergu

pour afficher un apercu de l'image sélectionnée sur la droite, ce qui vous permet de vérifier qu'il
s'agit du bon fichier. L'option Lier est détaillée page 7 ci-dessous. Quand l'option Lier n'est pas
cochée, l'image est enregistrée dans le document Calc.

Votre boite de dialogue Insérer une image peut étre sensiblement différente de celle
Note de la Figure 1, selon votre systeme d'exploitation et votre choix dans Outils >
Options > LibreOffice > Général d'utiliser les boites de dialogue LibreOffice.

Lier un fichier image

Pour créer un lien vers le fichier qui contient I'image au lieu d'en enregistrer une copie dans le
document Calc, utilisez la boite de dialogue Insérer une image et cochez l'option Lier. Un
message d'avertissement peut apparaitre pour vous demander de confirmer cette liaison ou
d'incorporer le fichier. L'image est alors affichée dans le document, mais quand le document est
enregistré, il contient seulement une référence au fichier image, et non l'image elle-méme. Le
document et I'image demeurent dans deux fichiers séparés, qui seront fusionnés temporairement
uniguement quand vous ouvrirez a nouveau le document.

Lier une image comporte deux avantages et un inconvénient :

* Avantage : vous pouvez modifier le fichier image séparément sans changer le document,
parce que le lien vers le fichier reste valide, et Iimage modifiée apparaitra la prochaine fois
que vous ouvrirez le document. Ce peut étre un grand avantage si vous (ou quelqu'un
d'autre, un graphiste par exemple) mettez a jour les images.

* Avantage : le lien peut réduire significativement la taille du document au moment de son

enregistrement, parce que le fichier image lui-méme n'est pas inclus. La taille de fichier
n‘est habituellement plus un probleme sur les ordinateurs modernes qui ont une mémoire
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de stockage conséquente, a moins que le document ne comporte de trés gros fichiers
graphiques. Calc peut supporter de gros fichiers.

* Inconvénient : Si vous envoyez le document a quelqu'un d'autre, ou si vous le déplacez
vers un autre ordinateur, vous devez également envoyer les fichiers image, ou le
destinataire ne pourra pas voir les images liées. Vous devez garder une trace de
I'emplacement des images et vous assurer gue le destinataire sache ou les déposer sur
une autre machine, pour que le document Calc puisse les retrouver. Par exemple, vous
pouvez conserver les images dans un sous-dossier appelé Images (dans le dossier qui
contient le document Calc) ; le destinataire du fichier Calc devra déposer les images dans
un sous-dossier qui porte le méme nom (dans le dossier qui contient le document Calc).

Si vous insérez la méme image plusieurs fois dans un document, vous pouvez
penser qu'il est intéressant de créer des liens. Cependant, ce n'est pas
nécessaire, parce que LibreOffice n'incorpore qu'une copie du fichier image dans
le document. (La suppression d'une ou plusieurs copies n'affecte pas les autres.)

Note

Incorporer des images liées
Si vous aviez au départ lié les images, vous pouvez facilement les incorporer (enregistrer dans le
document Calc) par la suite si vous le souhaitez, en totalité ou en partie. Pour ceci :

1) Ouvrez le document dans Calc.

2) Choisissez Edition > Liens dans la barre de menus.

La boite de dialogue Editer les liens liste tous les fichiers liés. Dans la liste Fichier source,
sélectionnez les fichiers que vous voulez modifier de lié & incorporé.

3) Cliquez sur le bouton Rompre le lien.

Editer les liens @
Fichier source Elément : Type Statut | Eermer |
Figurel.png PMG - Portable Metwork e Manuel
Figureld.png PMG - Portable Metwork  Immage Manuel | Aide |

| Actualiser |
| Modifier.. |
| Bompre le lien |

Fichier source file:/f/E:/Users/CCH/Documents/Libre Office/Figurel .png
Elément : PMG - Portable Metwork Graphic

Type: Image

Actualiser: Automatique Manue

Figure 2 : Boite de dialogue Editer les liens

Aller dans l'autre sens, d'incorporé a lié, n'est pas aussi facile : vous devez

Note supprimer et réinsérer chaque image, une a la fois, en cochant l'option Lier.
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Insérer une image depuis le presse-papiers

Avec le presse-papiers, vous pouvez copier des images dans un document Calc depuis un autre
document Calc, un autre composant de LibreOffice (Writer, Draw ...), ainsi que des programmes
tiers.

Pour ceci :
1) Ouvrez a la fois le document source et le document Calc ou vous voulez copier I'image.
2) Dans le document source, sélectionnez l'image a copier.
3) Appuyez sur Ctrl+C pour copier I'image dans le presse-papiers.
4) Basculez dans la fenétre Calc.
5) Cliquez pour placer le focus a I'endroit ou l'image doit étre insérée.
6) Appuyez sur Ctrl+V pour insérer l'image.

Attention  Si I'application depuis laquelle I'‘élément graphique est copié est fermée avant que
cet élément soit collé dans Calc, il peut arriver que l'image stockée dans le presse-
papiers soit perdue.

Insérer une image depuis la Gallery

La Gallery regroupe de facon pratique des objets réutilisables, comme des éléments graphiques
Ou sonores, que vous pouvez insérer dans vos documents.

La Gallery est disponible dans tous les composants de LibreOffice. Elle contient un certain nombre
d'éléments graphiques, mais vous pouvez ajouter vos propres images ou trouver des extensions
qui contiennent plus d'éléments. La Gallery est expliquée en détail dans le Chapitre 11 (Eléments
graphigues, Gallery et Fontwork) du Guide du débutant. Pour plus d'informations sur les
extensions, voir le Chapitre 14 (Paramétrer et personnaliser Calc) dans ce guide.

Cette section explique les bases de l'insertion d'images de la Gallery dans un document Calc.

1) Pour ouvrir la Gallery (Figure 3), cliquez sur l'icone Gallery (située du coté droit de la

barre d'outils Standard) ou choisissez Outils > Gallery dans la barre de menus.

2) Naviguez dans la Gallery pour trouver I'image désirée.

3) Pour insérer I'image, faites un clic droit sur I'image et choisissez Ajouter > Copier, ou
cliquez et faites glisser l'image depuis la Gallery jusqu'a I'endroit désiré au sein du
document Calc en cours.

Par défaut, la Gallery est ancrée au-dessus de I'espace de travail de Calc. Pour étendre la Gallery,
positionnez le curseur au-dessus de la ligne qui la sépare du haut de I'espace de travail. Quand le
pointeur devient un symbole avec des lignes paralleles et des fleches, cliquez et faites glisser vers
le bas. L'espace de travail est redimensionné en conséquence.

Pour étendre la Gallery sans modifier I'espace de travail, enlevez I'ancrage pour qu'elle flotte au-
dessus de I'espace de travail. Pour ce faire, gardez appuyée la touche Ctrl et double-cliquez en
haut de la Gallery prés des icbnes d'affichage, ou appuyez sur la combinaison de touches
Ctrl+Maj+F10. Renouvelez I'opération pour l'ancrer a nouveau (la ramener a sa position initiale au-
dessus de l'espace de travail).

Quand la Gallery est ancrée, pour la masquer et voir I'espace de travail en entier, cliquez sur le
bouton Masquer/Afficher au milieu de la ligne séparant la Gallery de I'espace de travail (cerclé
Figure 3).

Pour fermer la Gallery, choisissez Outils > Gallery pour désélectionner la ligne Gallery, ou cliquez
a nouveau sur l'icone Gallery.

Ajouter des images 9
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Figure 3 : Gallery dans Calc

Modifier des images

Quand vous insérez une nouvelle image, vous pouvez avoir besoin de la modifier afin de I'adapter
a votre document. Cette section décrit l'utilisation de la barre d'outils Image, le redimensionnement
et le rognage. Les modifications faites dans Calc n'affectent pas I'image d'origine, qu'elle soit
incorporée ou liée.

Calc fournit plusieurs outils pour travailler avec les images. Ces outils sont suffisants pour les
besoins ordinaires de la plupart des utilisateurs. Cependant, pour obtenir des résultats
professionnels, il est préférable d'utiliser un programme de manipulation d'images tel que GIMP
pour modifier les images (par exemple, pour rogner, redimensionner, faire pivoter et changer les
valeurs de couleurs) et ensuite insérer le résultat dans Calc. GIMP est un programme graphique
libre qui peut étre téléchargé depuis http.//www.gimp.org/downloads/.

Utiliser la barre d'outils Image

Quand vous insérez une image ou en sélectionnez une déja présente dans le document, la barre
d'outils Image apparait. Vous pouvez la paramétrer pour qu'elle soit toujours présente (Affichage
> Barre d'outils > Image). Les boutons de contrdle d'image de la barre d'outils Image peuvent
également étre ajoutés a la barre d'outils Standard. Voir Chapitre 14 (Paramétrer et personnaliser
Calc) pour plus d'informations.

Cette barre d'outils peut étre soit flottante, soit ancrée. La Figure 4 montre la barre d'outils Image
flottante. Une courte explication des outils est fournie dans la table Tableau 1. Voir le Guide Draw
pour des explications plus détaillées.

Trois autres barres d'outils peuvent étre ouvertes depuis celle-ci : les barres d'outils Filtre
graphigue et Aligner, qui peuvent étre détachées et placées n'importe ou dans la fenétre, et la
barre d'outils Couleur, qui s'ouvre en tant que barre d'outils flottante séparée.

Avec ces quatre barres d'outils, vous pouvez appliquer de petites corrections aux éléments
graphiques ou obtenir des effets spéciaux.

Modifier des images 10
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Tableau 1. Fonctions de la barre d'outils Image (de gauche a droite)
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L1113

Nom

Filtrer

Mode Graphique

Couleur
Transparence
Ligne
Remplissage
Ombre

Rogner l'image
Changer
d'ancrage

Envoyer a
l'avant

Envoyer a
l'arriere

Au premier plan/
A l'arriere-plan

Alignement

Effet

Affiche la barre d'outils Filtre graphique. Voir page 12.

Comporte plusieurs modes de couleur dans la liste
déroulante. Voir page 12.

Ouvre la barre d'outils Couleur, décrite page 13.

Détermine la transparence de I'image sélectionnée. Voir
page 13.

Ajuste le style de bordure de l'image sélectionnée.

Remplit la zone avec la couleur ou le motif sélectionnés.

Ajoute une ombre aux cbtés de l'image.

Ouvre la boite de dialogue Rogner, ou vous pouvez
supprimer une partie de l'image. Voir page 13.

Bascule entre I'ancrage de l'image a la cellule ou a la
page. Voir page 23.

Envoie l'image sélectionnée sur le dessus de la pile. Voir
page 22.

Pousse l'image sélectionnée au fond de la pile. Voir page
22.

Permet a I'image de flotter au premier plan ou de faire
partie de l'arriere-plan (derriere les cellules). Voir page 22.

Si deux images ou plus sont sélectionnées, ajuste
I'alignement horizontal ou vertical des images entre elles.
Voir page 24.

Modifier des images
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Choisir un mode graphique

Vous pouvez changer la couleur des images en niveaux de gris en sélectionnant I'image, puis en
sélectionnant Niveaux de gris dans la liste Mode Graphique.

Tableau 2. Modes graphiques

Mode Graphique

Par défaut

Niveaux de gris

Noir/Blanc

Filigrane

Utiliser les filtres graphiques
Cliquez sur l'icne Filtrer N
qui fournit des outils pour appliquer des filtres élémentaires de photographie et

d'effets aux images depuis Calc. Pour détacher cette barre d'outils et la placer
n'importe ou sur I'écran, cliquez sur les trois lignes paralléles et faites glisser.

Effet
Conserve l'image telle qu'elle a été insérée.

Affiche I'image avec des niveaux progressifs de gris.
Convertit I'image en une image monochromatique noire et blanche.

Transforme l'image en un filigrane qui se fond dans l'arriere-plan.

B o6
L 4 E %
Z 5§

-

pour afficher la barre d'outils Filtre graphique,

Tableau 3. Filtres graphiques et leurs effets

I

(2]
(=}

ne

D

B g@
a5 2o
ELP
M
1]

°¢+¢.°
P

il

s

[+

O\ ="

Nom

Invertir

Adoucir

Augmenter la
netteté

Supprimer les
interférences

Solarisation

Vieillissement

Poster

Pop'art

Dessin au
fusain

Relief

Effet

Inverse les couleurs de l'image a la facon d'un négatif.

Appligue un flou gaussien a l'image pour en adoucir les arétes.

Augmente la netteté de l'image.

Applique une grossiére réduction de bruit.

Inverse certaines tonalités, ce qui produit un soulignement accentué
des zones en évidence.

Applique un filtre sépia.
Ouvre une boite de dialogue pour déterminer le nombre de couleurs a
postériser. Cet effet repose sur la réduction du nombre de couleurs. II

fait ressembler des photos a des peintures.

Appligue un style Pop Art a l'image.

Applique un style de dessin au fusain a l'image.

Ouvre une boite de dialogue pour créer des reliefs. Vous pouvez
choisir la position de la source de lumiére imaginaire qui détermine le
type d'ombre.

Modifier des images
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Icone Nom Effet

Assemble de petits groupes de pixels en zones rectangulaires de
:I': Mosaique méme couleur. Plus les rectangles sont grands, moins l'image
: graphigue a de détails.

Appliquer consécutivement plusieurs filtres d'image LibreOffice aura pour
conséquence la dégradation progressive de la qualité de l'image. Les filtres
d'image de Calc utilisent des algorithmes dits destructifs, avec lesquels chaque

Attention filtre est appliqué a I'image immédiatement, changeant ainsi les données d'origine.
Des transformations successives conservent de moins en moins les données de
départ, ce qui compromet la qualité de I'image insérée. Ce peut étre acceptable

pour des documents simples, mais l'usage de logiciels spécialisés dans I'édition
de photos et d'images est vivement recommandé pour des manipulations plus
complexes.

Couleur *

Ajuster les couleurs

Bow =
Utilisez la barre d'outils Couleur pour ajuster indépendamment les canaux rouge, _ .
vert et bleu de l'image, ainsi que sa luminosité, son contraste et son gamma. T 0% |5
o Hox |5
Définir la transparence

0% =

o Pon |2
Modifier la valeur de pourcentage dans le champ Transparence z[0 de la €lox |2

barre d'outils Image va rendre I'image plus ou moins transparente. Ce peut étre utile
quand vous créez un filigrane ou lorsque vous déplacez une image en arriere-plan. | - 1,00

L3

Personnaliser les lignes, les remplissages et les ombres

Les icones Ligne, Remplissage et Ombre ouvrent des boites de dialogue ol vous pouvez
personnaliser ces éléments. Les détails sont dans le Guide Draw.

Rogner les images

Si vous étes intéressé seulement par une partie de I'image pour I'objectif de votre document, vous
pouvez vouloir en rogner (couper et enlever) certaines parties. L'interface utilisateur de Calc pour
rogner une image n'est pas tres évidente, et il est peut-étre plus judicieux d'utiliser le module Draw
ou un logiciel graphique.

Pour utiliser I'outil de rognage de Draw, coupez votre image dans Calc, créez un
nouveau document Draw et collez votre image a l'intérieur. Dans Draw, cliquez sur

Astuce le bouton Rogner l'image £ et ajustez a la souris le rognage a I'aide des
poignées rouges. Puis coupez votre image modifiée dans Draw et collez-la dans
Calc.

Cliquez sur l'icone Rogner lI'image t pour ouvrir une boite de dialogue ou vous pouvez
sélectionner une portion de lI'image a afficher.

Il n'est pas possible d'utiliser la souris pour sélectionner la zone a rogner, comme vous pouvez le
faire dans Draw. Au lieu de ¢a, dans la boite de dialogue Rogner, spécifiez a quelle distance des
bordures du haut, du bas, de gauche et de droite de I'image le rognage doit avoir lieu, comme
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illustré Figure 5. Dans l'apercu, notez que la sélection aprés rognage est mise en évidence avec
un rectangle.

Dans la boite de dialogue Rogner, vous pouvez contréler les paramétres suivants :

Regner X5
Rogner
@ Conserver I'échelle OK |
Conserver la taille de 'image ; | Annuler |
Gauche |0,00cm = Haut 0,00cm = | Aide |

Bas 0,00cm =

4(k

Droite 1.58cm

Echelle
Largeur 105%

4k

[k

Hauteur | 100%

Taille de l'image

4k

Largeur 15,01cm 15,88cm=11,91cm (96 PPI)

Hauteur 1195cm = Taille d'origine

Figure 5 : Boite de dialogue Rogner

Conserver I'échelle
Conserve I'échelle d'origine de l'image lors du rognage, ce qui a pour conséquence de faire
évoluer la taille de I'image.

Conserver la taille de I'image
Conserve la taille d'origine de I'image lors du rognage, ce qui a pour conséquence de changer
I'échelle de l'image.

Gauche et Droite
Saisissez une valeur positive pour réduire lI'image du cété gauche ou droit, ou une valeur
négative pour ajouter un espace vide du c6té gauche ou droit de I'image. Si Conserver
I'échelle est cochée, la largeur de I'image sera diminuée ou augmentée de cette valeur. Si
Conserver la taille de I'image est cochée, I'échelle horizontale sera augmentée ou diminuée
en conséquence.

Haut et Bas
Saisissez une valeur positive pour réduire lI'image du cété haut ou bas, ou une valeur négative
pour ajouter un espace vide du c6té haut ou bas de lI'image. Si Conserver I'échelle est
cochée, la hauteur de l'image sera diminuée ou augmentée de cette valeur. Si Conserver la
taille de I'image est cochée, I'échelle verticale sera augmentée ou diminuée en conséquence.

Echelle
Cette section vous permet de modifier I'échelle de I'image sélectionnée. Dans les champs
Largeur et Hauteur, saisissez sous forme de pourcentage la valeur d'échelle pour la largeur et
la hauteur de l'image.

Modifier des images 14



Taille de I'image
Cette section vous permet de modifier la taille de I'image sélectionnée. Dans les champs
Largeur et Hauteur, saisissez la largeur et la hauteur de l'image.

Taille d'origine
La taille d'origine de l'image est affichée au-dessus du bouton Taille d'origine. Cliquez sur ce
bouton pour réinitialiser I'image a une échelle de 100 % et a ses largeur et hauteur d'origine
(en tenant compte des valeurs de la section Rogner).

Faites attention avec les opérations de rognage. Dans la boite de dialogue Rogner,

les valeurs de largeur et de hauteur des sections Echelle et Taille de I'image peuvent

A étre manipulées de facon indépendante. Changer une valeur sans modifier la
seconde peut aboutir a des déformations importantes et indésirables de l'image.

Attention

La forme rognée est toujours un rectangle ; les formes plus complexes ne sont pas possibles avec
Calc. Si vous en avez besoin, utilisez un logiciel spécialisé dans I'édition de photos et d'images,
puis importez I'image dans Calc.

Si vous rognez une image dans Calc, l'image elle-méme n'est pas modifiée. Si
Note vous exportez le document en HTML, l'image d'origine est exportée, et non l'image
rognée.

Redimensionner une image

Pour redimensionner une image :

1) Cliguez sur lI'image, si nécessaire, pour afficher les poignées vertes de
redimensionnement.

2) Positionnez le pointeur de la souris au-dessus d'une de ces poignées vertes. Le pointeur
se change en une forme qui donne une représentation graphique (fleche double) de la
direction du redimensionnement.

3) Cliquez et faites glisser pour redimensionner l'image.

4) Relachez le bouton de la souris quand vous étes satisfait de la nouvelle dimension.

Les poignées de coin redimensionnent & la fois la largeur et la hauteur d'un objet graphique
simultanément, tandis que les quatre autres poignées ne changent qu'une dimension a la fois.

Pour conserver les proportions d'origine de I'élément graphique, utilisez Maj+clic
Astuce sur l'une des poignées de coin, puis faites glisser. Faites attention de relacher le
bouton de la souris avant de relacher la touche Maj.

Redimensionner une image bitmap (matricielle) comme une photo affecte négativement sa
résolution, en provoquant un certain flou. Il est préférable d'utiliser un logiciel spécialisé pour
dimensionner correctement votre image avant de l'insérer dans votre document, si c'est possible.

Pour un redimensionnement plus précis, utilisez la boite de dialogue Position et taille, comme
décrit page 16 ci-dessous.

Modifier des images 15



Utiliser le menu contextuel d'une image

Beaucoup d'options accessibles depuis la barre d'outils Image peuvent également étre atteintes en
faisant un clic droit sur I'image pour ouvrir un menu contextuel. Des options supplémentaires ne
sont disponibles que dans ce menu ; elles sont décrites dans cette section.

Texte

Ouvre une boite de dialogue ou vous pouvez paramétrer les options pour le texte qui recouvre
I'image. Pour écrire un texte sur un élément graphique, cliquez sur ce dernier afin de le
sélectionner et appuyez sur Entrée (ou double-cliquez). Un curseur apparaitra alors au centre de
cet élément graphique. Tout texte saisi fera partie intégrante de cet ensemble graphique ; de ce
fait, si ce dernier est déplacé, le texte le suivra.

Position et taille

Ouvre la boite de dialogue ci-dessous, ou vous pouvez changer la taille, la position, la rotation,
I'inclinaison et le rayon d'angle de l'image.

Position et taille ==

Fosition et taille |Rotation | Inclinaizon et rayon d'angle

Position
Point de base
Position X 0,20em . ’T ‘“—‘T
' ' '
Fosition ¥ 0,00cm = | |
—
Taille
Point de base
Largeur 17.06cm = "T L T
i i i
Hauteur 1 46ecm - fl ~ fL

Propertionnel

Protéger Adapt
Positicn Adapter la largeur au t

Taille Mdapter la hauteur au t

Figure 6 : Boite de dialogue Position et taille

Faire pivoter une image

Sélectionnez I'image, puis choisissez Format > Image > Position et taille depuis la barre de
menus, ou faites un clic droit et choisissez Position et taille dans le menu contextuel.

1) Sélectionner l'onglet Rotation de la boite de dialogue (voir Figure 7).

2) Dans la section Point de rotation, sélectionnez les positions X et Y du point de pivot, a
partir des c6tés gauche et supérieur, avec les données des champs correspondants, ou
fixez le point de pivot a I'une de ses positions prédéfinies dans le graphique Paramétrages
par défaut.

3) Dans la section Angle de rotation, sélectionnez I'angle dans le champ Angle, ou choisissez
un angle multiple de 15 degrés prédéfini dans le graphique Paramétrages par défaut.
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4) Vous pouvez revenir aux valeurs présentes lors de 'ouverture de la boite de dialogue avec
le bouton Réinitialiser.

5) Cliquez sur OK pour faire pivoter l'image.

Position et taille 5]

Position et taille| Rotation [nclinaison et rayon d'angle

Point de rotation

Paramétrages par défaut

Position X 17 96cm = *I L ’|"
Position ¥ 4.9%cm = e & '
|

Angle de rotaticn
Paramétrages par défaut

Angle = pr Ny
4 -
g °
: 2
‘. - O
oK ] | Annuler || Aide || Reinitialiser

Figure 7 : Onglet de paramétrage de la rotation d'une image

Taille d'origine

Réinitialise les dimensions de l'image avec les valeurs telles qu'elles étaient définies lors de
l'insertion de l'image.

Description

Vous pouvez ajouter, en tant que métadonnées, un titre et une description a I'image. Cette
information est utilisée par les outils d'accessibilité (comme un logiciel de lecture d'écran) et en
gualité d'attributs de type ALT (alternatifs) si vous exportez le document en HTML.

Nom

Vous pouvez affecter un nom personnalisé a l'image, pour pouvoir la retrouver plus facilement
dans le Navigateur.

Si vous collaborez a une équipe pour une vaste publication multipages, il peut étre
Astuce intéressant de donner aux éléments graphiques et autres objets des noms et des
descriptions significatifs pour contribuer a une meilleure communication.

Refléter

Refléte I'image horizontalement ou verticalement.
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Assigher une macro

Ajoute une fonctionnalité programmée a l'image. Calc fournit de riches fonctionnalités de macros.
Les macros sont présentées Chapitre 12 (Macros Calc).

Groupe

Pour regrouper des images :

1) Sélectionnez une image, puis gardez appuyée la touche Maj et cliquez sur chacune des
autres images que vous voulez inclure dans le groupe. Le “cadre de sélection” invisible
(avec les huit poignées vertes) s'étend pour inclure toutes les images sélectionnées.

2) Une fois les images sélectionnées, choisissez Format > Grouper > Grouper dans la barre
de menus, ou placez le pointeur de la souris au-dessus de I'une des images et, quand le
pointeur n'a plus l'apparence d'une fleche, mais d'une fleche a quatre pointes, faites un clic
droit et choisissez Groupe > Grouper dans le menu contextuel.

Une fois les images regroupées, le menu contextuel fournit d'autres options (Dissocier et Editer
le groupe) ainsi que le menu Format > Grouper qui comprend Dissocier et Entrer dans le
groupe. Pour plus d'informations sur le regroupement, voir le Guide Draw.

Hyperlien

Vous pouvez définir une image en tant qu'hyperlien vers un autre endroit du classeur, un autre
document ou un site web. Pour ceci, sélectionnez I'image, faites un clic droit et choisissez
Hyperlien dans le menu contextuel. La boite de dialogue Hyperlien s'ouvre. Voir Chapitre 10 (Lier
les données de Calc) pour plus d'informations.

Compresser une image

Vous pouvez compresser une image afin de diminuer la taille de votre document. Pour ceci,
sélectionnez l'image, faites un clic droit et choisissez Compresser I'image dans le menu
contextuel. La boite de dialogue qui s'ouvre affiche les tailles et résolutions originales et affichées
dans le document, ainsi que la qualité de lI'image exprimée en kibioctets.

Vous pouvez choisir entre une compression JPEG et une compression sans perte (PNG), avec a
chaque fois la possibilité de saisir le niveau de qualité ou de compression. Vous pouvez également
modifier la taille et la résolution de I'image en choisissant un algorithme d'interpolation.

Une fois ces modifications saisies, utilisez le bouton Calculer pour calculer la nouvelle qualité de
I'image. Vous pouvez valider ces modifications en cliquant sur OK.

Editer avec un outil externe

Vous pouvez éditer une image avec un outil externe, afin de disposer de fonctionnalités plus
avanceées. Pour ceci, sélectionnez l'image, faites un clic droit et choisissez Editer avec un outil
externe dans le menu contextuel.

Utiliser les outils de dessin de Calc

Calc, comme les autres composants de LibreOffice, recéle toute une palette d'outils pour créer des
dessins personnalisés. Ce chapitre couvre les options par défaut dans Calc. Pour une explication
plus détaillée des outils de dessin et de leurs utilisations, voir le Guide Draw.

Généralement, si vous avez besoin de créer des dessins complexes, il est recommandé d'utiliser
LibreOffice Draw ou un autre programme de dessin.

Utiliser les outils de dessin de Calc 18



Pour commencer a utiliser les outils de dessin, choisissez Affichage > Barres d'outils > Dessin.
La barre d'outils Dessin apparait en bas de I'écran. Vous pouvez la détacher et la déplacer & un

endroit plus rationnel dans la fenétre.

' Feuillel [ f
S E @& T

U; I
- ©-o-E-V-¥%- =N

Figure 8 : Barre d'outils Dessin avec les icones par défaut

Tableau 4. Fonctions de la barre d'outils Dessin (de gauche a droite)

I
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e

% 9 B 2 & € |/

Nom

Sélectionner

Ligne

Rectangle

Ellipse

Ligne & main levée
Texte

Légende

Formes de base

Formes des
symboles

Fléches pleines
Organigrammes
Légendes
Etoiles

Points

Galerie Fontwork

A partir d'un fichier

Effet

Sélectionne des objets.

Dessine une ligne.

Dessine un rectangle. Pour dessiner un carré, appuyez sur
Maj pendant que vous faites glisser.

Dessine une ellipse. Pour dessiner un cercle, appuyez sur
Maj pendant que vous faites glisser.

Dessine une ligne a main levée.

Ajoute une boite de texte sans bordure.

Dessine une ligne terminée par un rectangle de Iégende.

Ouvre la barre d'outils Formes de base.

Ouvre la barre d'outils Formes des symboles.

Ouvre la barre d'outils de formes Fléches pleines.

Ouvre la barre d'outils de formes Organigrammes.

Ouvre la barre d'outils de formes Légendes.

Ouvre la barre d'outils de formes Etoiles.

Permet de modifier les points d'un polygone sélectionné.

Ouvre la Galerie Fontwork.

Insére une image avec la boite de dialogue Insérer une
image.

Utiliser les outils de dessin de Calc
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Icone Nom Effet

EE (Dés)activer Ouvre la barre d'outils Parametres 3D et convertit la forme
I'extrusion sélectionnée (si possible) en 3D.

Pour afficher d'autres icones, faites un clic droit sur la barre d'outils, sélectionnez Boutons
visibles et choisissez les outils que vous voulez voir apparaitre dans la barre d'outils.

Ic6ne Nom Effet

Dessine une ligne composée d'une série de segments droits.
Polygone Gardez appuyée la touche Maj pour positionner les nouveaux
points a des angles de 45 degrés.

.{L‘ Courbe Dessine une courbe de Bézier.

4] Arc d'ellipse Dessine un arc.

Dessine une forme remplie définie par I'arc d'un ovale et deux
lignes d'angle dans le document courant. Pour dessiner un

& Secteur d'ellipse secteur circulaire, appuyez sur Maj pendant que vous faites
glisser.
Dessine une forme remplie définie par un arc d'ellipse et une
'C) Segment de cercle ligne de diamétre dans le document courant. Pour dessiner
9 un segment de cercle, appuyez sur Maj pendant que vous
faites glisser.
g}% Animation de texte Insére un texte animé.

Si la prise en charge des langues asiatiques est activée (dans Outils > Options > Paramétres
linguistiques > Langues), deux outils supplémentaires peuvent étre ajoutés a la barre d'outils
Dessin : Texte vertical et Légende verticale.

Pour utiliser un outil de dessin :

1) Cliquez dans le document a I'endroit ou vous voulez que le dessin soit ancré. Vous pourrez
changer I'ancre plus tard, si nécessaire.

2) Sélectionnez I'outil dans la barre d'outils Dessin (Figure 8). Le pointeur de la souris se
transforme en une croix.

3) Déplacez le pointeur a I'endroit dans le document ol vous voulez que le dessin apparaisse
et glissez-déposez pour créer |'objet de dessin. Relachez le bouton de la souris. (Certains
outils ont d'autres impératifs : voir I'Aide ou le Guide Draw pour les détails.)

La fonction de dessin sélectionnée reste active, et vous pouvez donc dessiner d'autres
objets du méme type.

4) Pour arréter la fonction de dessin sélectionnée, appuyez sur la touche Echap ou cliquez
sur l'icbne Sélectionner (la fléche) de la barre d'outils Dessin.

5) Vous pouvez alors changer les propriétés (couleur de remplissage, type et épaisseur de
ligne, ancrage et autres) de I'objet de dessin en utilisant soit la barre d'outils Propriétés de
I'objet de dessin (Figure 9), soit les sélections et boites de dialogues atteintes en faisant un
clic droit sur lI'objet de dessin.
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Paramétrer ou changer les propriétés des objets de dessin

Pour paramétrer les propriétés d'un objet de dessin avant de le dessiner :

1)
2)

3)

Dans la barre d'outils Dessin (Figure 8), cliquez I'outil Sélectionner s .

Faites apparaitre la barre d'outils Propriétés de I'objet de dessin (Figure 9), si ce n'est pas
déja le cas, avec Affichage > Barres d'outils > Propriétés de I'objet de dessin.

Dans la barre d'outils, cliquez sur l'icbne de chaque propriété et choisissez la valeur que

vous voulez.

Ces propriétés par défaut s'appliguent uniquement au document et a la session en cours. Elles ne
sont pas mémorisées quand vous fermez le document, et elles ne s'appliquent pas aux autres
documents. Les propriétés par défaut s'appliquent a tous les objets de dessin, sauf les objets

textes.

Pour modifier les propriétés d'un objet de dessin existant, sélectionnez cet objet et continuez
comme indiqué ci-dessus.

D'autres outils et méthodes pour modifier et positionner des éléments graphiques sont décrits dans
“Positionner des éléments graphiques” ci-dessous.

Propriétés de I'objet de dessin

w

Iz” & |Cou|eur |EI|:| I

| & |58 E |bd-

Figure 9 : Barre d'outils Propriétés de I'objet de dessin

Tableau 5. Fonctions de la barre d'outils Propriétés de I'objet de dessin (de gauche a droite)

Nom

Ligne

Style de fleche

Style de ligne

Largeur de ligne

Couleur de ligne

Remplissage

Style de
remplissage

Pivoter

Modifier I'ancre

Envoyer a
l'avant

Effet

Ajuste le style de bordure de I'objet de dessin sélectionné.

Permet de choisir le style de fleche de I'objet de dessin
sélectionné.

Permet de choisir le style de ligne de I'objet de dessin
sélectionné.

Détermine la largeur de la ligne de I'objet de dessin
sélectionné.

Permet de choisir la couleur de ligne de I'objet de dessin
sélectionné.

Remplit I'objet de dessin avec la couleur ou le motif
sélectionnés.

Détermine le type et le style de remplissage de I'objet de
dessin sélectionné.

Permet de faire pivoter I'objet de dessin sélectionné.

Permet de modifier I'ancrage de I'objet de dessin
sélectionné.

Envoie I'objet de dessin sélectionné sur le dessus de la
pile.

Utiliser les outils de dessin de Calc
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Icéne Nom Effet

Envoyer a —_ L , .
g I‘arrié¥e Pousse I'objet de dessin sélectionné au fond de la pile.

= Au premier plan/ Permet a I'objet de dessin de flotter au premier plan ou de

== A l'arriére-plan faire partie de l'arriere-plan (derriere les cellules).
. Si deux objets de dessin ou plus sont sélectionnés, ajuste
Hé& - Alignement - , . ,
l'alignement horizontal ou vertical des objets entre eux.

Redimensionner un objet de dessin

Sélectionnez l'objet, cliquez sur I'une des huit poignées qui I'entourent et faites-la glisser jusqu'a sa
nouvelle dimension. Pour un redimensionnement a I'échelle, sélectionnez I'une des poignées de
coin et gardez appuyée la touche Maj pendant que vous faites glisser la poignée.

Pour un contréle plus précis de la taille de I'objet, utilisez la boite de dialogue Position et taille (voir
“Position et taille” page 16) pour paramétrer la largeur et la hauteur indépendamment. Si l'option
Proportionnel est cochée, alors les deux dimensions changeront en méme temps pour que la
proportion soit maintenue, permettant ainsi un redimensionnement calculé a I'échelle.

Grouper des objets de dessin

Pour grouper des objets de dessin :

1) Sélectionnez un objet, puis gardez appuyée la touche Maj et sélectionnez les autres objets
que vous voulez inclure dans le groupe. Le cadre de sélection s'étend pour inclure tous les
objets sélectionnés.

2) Une fois les objets sélectionnés, placez le pointeur de la souris au-dessus de I'un des

objets et choisissez Format > Grouper > Grouper dans la barre de menus ou faites un
clic droit et choisissez Groupe > Grouper dans le menu contextuel.

Positionner des éléments graphiques

Les éléments graphiques peuvent étre positionnés dans LibreOffice Calc pour se combiner et
construire des éléments plus complexes.

Organiser des éléments graphiques

Les éléments graphiques dans un document Calc sont organisés d'une maniére identique a une
pile de cartes a jouer. Si vous ajoutez des images supplémentaires au document, chaque image
occupe une nouvelle couche au sommet de la pile. Pour organiser les éléments graphiques, vous
devez dire a Calc de changer I'ordre des couches dans la pile.
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Figure 10 : Effet de disposition des couches

Calc dispose de plusieurs options de base pour réorganiser la disposition des images. Ces options
sont accessibles par la barre d'outils Image et par le menu contextuel Disposition de l'image :

Envoyer a I'avant
Place l'image au sommet de tous les autres éléments graphiques ou textes.

Envoyer vers l'avant
Envoie I'image un niveau au-dessus dans la pile (axe Z). Selon le nombre d'objets qui se
recouvrent, vous pourrez avoir besoin d'appliquer cette option plusieurs fois pour obtenir le
résultat désiré.

Envoyer vers l'arriére
L'opposé de Envoyer vers l'avant ; envoie I'image sélectionnée un niveau en dessous dans la
pile d'objets.

Envoyer a l'arriére
Envoie le graphique sélectionné au niveau le plus bas de la pile, le couvrant ainsi par les
autres éléments (graphiques et textes).

Au premier plan et A l'arriére-plan
Une image ou un objet de dessin peut étre également envoyé a l'arriere-plan. Ce n'est pas la
méme chose que Envoyer vers I'avant ou Envoyer vers l'arriére, qui fixent I'ordre d'un certain
nombre d'éléments graphiques qui se recouvrent. Cette fonctionnalité repousse I'élément
graphique derriére les cellules, ce qui permet de les maodifier sans affecter cet élément.

Un élément graphique en arriére-plan a une entrée de menu Au premier plan, au lieu de A
I'arriére-plan.

Ancrer des éléments graphiques

Les ancres indiquent a un élément graphique comment rester en relation avec les autres éléments.

Ancrer a la page
Ancrer un €lément graphique a la page lui permet d'étre positionné a un endroit particulier de la
page. L'élément ne bouge pas quand des cellules sont ajoutées ou supprimées. C'est
I'équivalent d'une référence absolue. L'élément graphigue restera toujours en cellule B10 si
c'est la qu'il a été placé.
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Ancrer a la cellule
Ancrer un €lément graphique a une cellule permet de s'assurer que cet élément restera
toujours avec le contenu auquel il a été associé a l'origine. Si un élément graphique est ancré a
la cellule B10 et une nouvelle ligne est insérée au-dessus, I'élément graphique sera alors ancré
a la cellule B11. C'est I'équivalent d'une référence relative.

Par exemple, Figure 11, I'image de gauche est ancrée a la cellule B2 (dans laguelle on a saisi XXX
pour indiquer ou l'image est ancrée). L'image de droite est ancrée a la page.
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Si deux lignes sont insérées au-dessus des images, l'image ancrée a la cellule va descendre de
deux lignes et I'ancrage changera. L'image ancrée a la page ne bougera pas. Ceci est illustré
Figure 12. Notez que le symbole d'ancrage et que les XXX sont descendus cellule B4.
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Figure 11 : Ancrage — avant insertion

Figure 12 : Ancrage - apres insertion

Aligner les éléments graphiques

Vous pouvez aligner plusieurs éléments graphiques les uns par rapport aux autres. Pour ceci :

1) Sélectionnez tous les éléments graphiques a aligner (Maj+clic sur chacun). Les éléments
seront entourés par un cadre de sélection avec huit poignées vertes.

2) Dans la barre d'outils Image, cliqguez sur l'icbne Alighement et cliquez sur l'une des six
options.

Ou encore, positionnez le pointeur de la souris au-dessus de l'un des éléments. Quand le
pointeur devient une fleche & quatre pointes, faites un clic droit et choisissez Alignement,
puis l'une des six options.

Positionner des éléments graphiques 24



Parmi les six options, trois concernent l'alignement horizontal (gauche, centré, droite) et trois
concernent l'alignement vertical (en haut, centré, en bas).

Créer une image map

Une image map définit les zones cliquables d'une image, avec des hyperliens vers des adresses
web, d'autres fichiers sur l'ordinateur ou d'autres parties du méme document. Les zones cliquables
sont les équivalents graphiques des textes avec hyperliens. Si vous cliquez dans une zone
cliquable, Calc va ouvrir la page liée avec le programme approprié (par exemple, le navigateur par
défaut pour une page HTML ; LibreOffice Calc pour un fichier .ods ; un lecteur PDF pour un fichier
PDF). Vous pouvez créer des zones cliquables de différentes formes et inclure plusieurs zones
dans la méme image.

Pour utiliser I'éditeur d'image map :
1) Dans votre classeur, sélectionnez l'image dans laquelle vous voulez définir des zones
cliguables.

2) Choisissez Edition > Image Map dans la barre de menus. L'Editeur d'Image Map (Figure
13) s'ouvre.

3) Utilisez les outils et les champs de la boite de dialogue décrite ci-dessous pour définir les
zones cliguables et les liens dont vous avez besain.

4) Cliguez sur l'icbne Appliquer 4 pour appliquer les paramétrages.

=]
5) Ceci étant fait, cliguez sur l'icbne Enregistrer i si vous souhaitez enregistrer lI'image
map en tant que fichier indépendant, puis cliquez sur la croix dans le coin supérieur droit
pour fermer la boite de dialogue.

La zone principale de la boite de dialogue montre I'image dans laquelle des zones cliquables sont
définies. Une zone cliquable est identifiée par une ligne montrant sa forme.

La barre d'outils en haut de la boite de dialogue contient les outils suivants :
* Bouton Appliquer : cliguez sur ce bouton pour appliquer les modifications.
* |cbnes Ouvrir, Enregistrer et Sélectionner.

e Qutils pour dessiner une forme de zone cliquable : ces outils fonctionnent de la méme
facon que les outils correspondants dans la barre d'outils Dessin.

* Editer, Déplacer, Insérer, Supprimer des points : outils d'édition avancée pour manipuler
la forme d'un polygone de zone cliquable. Sélectionnez I'outil Editer des points pour activer
les autres accessoires.

* Icbnes Annuler et Rétablir.
* |cbne Actif : bascule I'état de la zone cliquable sélectionnée de Actif a Inactif.

* Macro : associe une macro a la zone cliquable au lieu de lui associer un simple lien
hypertexte.

* Propriétés : paramétre les propriétés de I'hyperlien et permet de lui ajouter un attribut
Nom.
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Editeur d'Image Map ==
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Adresse: http://fr.librecffice.arg/ Izl
Teute: Aller sur le site web de la communauté francophone Cadre: | _self |Z|
English riFran;a |5u Deutsch
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Figure 13 : Boite de dialogue pour créer ou modifier une image map

Au-dessous de la barre d'outils, précisez pour la zone cliquable sélectionnée :

* Adresse : 'adresse pointée par I'hyperlien. Vous pouvez également pointer vers une ancre
dans votre document ; pour le faire, tapez I'adresse dans le format suivant : #nom_ancre
(voir les astuces ci-dessous).

¢ Texte : saisissez le texte que vous voulez voir apparaitre quand le pointeur de la souris se
trouve au-dessus de la zone cliquable.

* Cadre : définit ou la cible de I'nyperlien doit étre ouverte : choisissez entre _blank (ouvre la
cible dans une nouvelle fenétre de I'explorateur), _self (ouvre la cible dans la fenétre de
I'explorateur active), _top ou _parent.

Image Map n'est pas approprié lorsque toute I'image doit étre cliquable et doit pointer
sur un seul lien ; dans ce cas, faites un clic droit sur lI'image puis choisissez
Hyperlien dans le menu contextuel.

L'éditeur Image Map ne dispose pas de navigateur permettant de rechercher et
sélectionner le document cible. Cliquez dans la barre d'outils Standard sur l'outil
Hyperlien, sélectionnez le document, copiez-collez 'URL depuis la boite de dialogue
Hyperlien vers la boite de dialogue Image Map.

La valeur _self pour le cadre de la cible fonctionnera correctement dans la plupart
des cas. Il n'est par conséquent pas recommandé d'utiliser les autres possibilités, a
moins que cela ne soit absolument nécessaire.

Astuces
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